HOBOware for PC and Mac, Version 3.7.24 
Last updated June, 15, 2022 
Welcome to HOBOware.  This version of HOBOware is available to customers of Onset Computer Corporation under the terms of the Software License Agreement contained in the installation programs.  This agreement is also available via the Onset Web site at:
http://www.onsetcomp.com/corporate/legal/software-license-agreement

___________________________
 
Installation of HOBOware software:
PC Users:
	Please double-click "HOBOware_Setup.exe".  When the installer comes up, follow the instructions. 

Mac Users:
	The procedure will vary depending on whether you are working from a product CD or USB Drive or a downloaded installer file.
 
 	If using a CD or USB Drive: Please double-click "HOBOware.pkg" and follow the instructions. 
 
 	If you have downloaded the installer, go to System Preferences > Security & Privacy > General. Be sure "Allow applications downloaded from:" is set to "Mac App Store and identified developers" or "Anywhere". please double-click the file named HOBOware_Signed_Installer.dmg, then double-click the HOBOware.pkg file. NOTICE: Versions of OS X earlier than macOS 10.14 are no longer supported but HOBOware may still work on earlier versions of OS X.

The Java Runtime Environment (JRE) for Windows, available from Oracle America, Inc., is now bundled with HOBOware so you no longer need to have a Java Runtime Environment separately installed on your computer. HOBOware for Windows comes with Java 8 and HOBOware for Macintosh comes with Java 9.

___________________________

Please Note:
For Mac users upgrading from a pre-3.2.2 HOBOware release, the HOBOware folder has moved from the user's Library/Application Support folder to the user's Documents folder.

Sample datafiles are contained in the installer and are also on the CD or USB Drive.  On the PC, these files are also installed in the common documents area at \Users\Public\Public Documents\HOBOware Public Files\Sample Datafiles on Windows 7, 8 or 10.  On the Mac, these files are installed in the user's Documents/HOBOware/Sample Datafiles folder.

When upgrading to a newer version:
It is highly recommended that you not use older versions of HOBOware once you have upgraded to a newer version of HOBOware. As noted above, some files change locations as HOBOware continues to evolve and having those files in two or more places can causes unforeseen problems when running HOBOware.

System Requirements:
HOBOware 3.7.24 has some basic common System Requirements that are presented in the list below. If using HOBOware as the data collection server for a network of Indoor Wireless HOBO data nodes you may want to consider the configuration guidelines provided in the table.  There are more detailed configuration recommendations available on the Onset Web site at http://www.onsetcomp.com/tech-note/hoboware-performance

	* 	PC: Windows 10 (Home, Pro), Windows 11 (Home, Pro).
	*	Mac: macOS Versions 10.15 (Catalina), 11.0 (Big Sur), 12.0 (Monterey)
		While HOBOware may run using a previous version of OS X, those earlier versions of OS X are specifically no longer supported.
	*	One of the following Internet browsers: The most recent version of Safari, Microsoft Internet Explorer, Microsoft Edge, Firefox or Google Chrome.  
	*	Minimum screen resolution of 1024x768. Recommended screen resolution of 1280x800 or greater particularly for non-English users.
	*	256+ colors
	*	Processor Speed, Memory and Disk Space:

		High End	 Mid Range	Low End	Lowest End
	CPU	2.9 GHz	 2.0 GHz	1.8 GHz	1.8 GHz
		dual core	 dual core	single core	single core
 	RAM	3 GB	 2 GB	1.5 GB	1 GB
 	Disk Space* see note	100 GB+ 	 50 GB+	20 GB+ 	300 MB
 	User Model	4	 3	2	1

The User Model row suggests some guidelines for using the Processor Speed and Memory table:
User Model 1 - Using HOBO Data loggers only, no data nodes – traditional desktop user
User Model 2 - Using HOBO Data loggers and up to 5 data nodes, 20 sensors
User Model 3 – Using HOBO Data loggers and up to 50 data nodes, 100 sensors
User Model 4 – Using HOBO Data loggers and up to 100 data nodes, 200 sensors

* Disk Space – Defining the disk space requirements for HOBOware depends on the proposed use. The table above describes the disk space needed for a traditional desktop user, allowing for installation of the program and storage of data files. For users of HOBO data nodes, the space requirements depend on a variety of factors, including the number of nodes, the number of sensors, the frequency of data sampling, the longevity of deployments, and other factors.  Please see the Knowledge Base and visit the Forums on the Onset Web site for more details, at http://www.onsetcomp.com/support

NOTICE
HOBOware 3.7.24 is built with Java 1.8.0_131 on Windows and on OS X. 

Time zone note: Now that the Java Runtime Environment is bundled with HOBOware, there may be problems updating to the Olson Timezone Database for a given locale. Onset is looking into this problem and will offer an option for this in the future.





Bug Fixes in HOBOware 3.7.24

Migrated to log4j 2.17.1
Retire RX3000 Manager functionality	
*** Known Issues ***

HOBOnode Viewer does not work on Macintosh
HOBOnode Manager and the Plot/Export feature for the HOBOnode database work on both Windows and Macintosh. But the feature to view HOBOnode Manager as a website, HOBOnode Viewer, does not work on Macintosh. Read on if you want to know the reason.

In order to digitally sign and notarize HOBOware for Macintosh Operating Systems 10.14.5 and above, we were forced to use Java 9 to bundle with HOBOware but there is a problem getting HOBOnode Viewer to work with Java 9. We are able to use Java 8 on the Windows version of HOBOware and HOBOnode Viewer continues to work with Java 8.

So, if you need to use HOBOnode Viewer, please use the Windows version of HOBOware.
 

Bug introduced with HOBOmobile v1.9.1 corrected
If an MX1102, the CO2 Logger, has been launched with HOBOmobile v1.9.1, the header of the logger datafile will be reported to be corrupted if older versions of HOBOware attempt to launch, read out or check the status of the logger. HOBOware 3.7.15 and above correct that problem.

Gmail and HOBOnode Alarm Alerts and Data Delivery
Google has tightened security on its Gmail SMTP servers so using smtp.gmail.com to deliver HOBOnode Alarm Alerts or HOBOnode Data will fail. Starting with HOBOware v3.7.14, we have enabled you to use Gmail for these features IF YOU ARE WILLING TO DECREASE THE SECURITY OF YOUR GMAIL ACCOUNT. We do not recommend this but if you need this ability, that is a possible way to do it.

If you use HOBO Data Nodes and never shut down HOBOware and background HOBO Data Node Communication
Using HOBO Data Nodes and the associated database takes a lot of memory. To help with this, we use a disk caching utility to temporarily save some data stored in RAM to the disk drive. But the disk data file can grow as long as HOBOware and/or background HOBO Data Node Communication is running. So, you may want to completely shut down HOBOware and the background HOBO Data Node Communication every week or so to reset the size the of the disk data cache file.

Another option is to reconfigure the disk cache utility but this can be a complex procedure so you should contact Onset Computer Support for more information.


HOBOnode Manager on Windows
There may be a problem using HOBOnode Manager on some Windows computers if the "USB Selective Suspend Setting" is enabled. This shuts down the USB port if no activity is detected. To disable this feature (list here is modified from the page linked below):

Open Control Panel
Go to: Hardware and Sound->Power Options
Find your preferred power plan and click “Change plan settings”
Click “Change advanced power settings”
A dialog box will open
Find the entry “USB settings” and expand it
Expand the entry “USB selective suspend setting”
Use the drop-down menu to disable the setting in the dialog
Click "OK"

For more information, you can go to this link at Gizmo's Freeware:
http://www.techsupportalert.com/content/how-fix-annoying-windows-usb-problem.htm

The Optic USB Base Station and Windows 8.1 and 10
Updates to Windows 8.1 and Windows 10 cause a problem with the Onset Optic USB Base Station (part number BASE-U-4) and the HOBO Waterproof Shuttle (part number U-DTW-1). The new Windows power saving updates may cause the Base Station and Waterproof Shuttle to appear inactive even though there is a device physically attached. This will impact any loggers used with the optic base station or shuttle, including: U20, U22, U23, U24, U26, UA Pendant, UTBI TidbiT.

There are three known workarounds:

1) Unplug and plug the Optic Base Station or Waterproof Shuttle each time you change loggers attached to them. 

2) Open the Device Manager and force a scan of USB devices.
   a) Select Settings and then select the Devices group. 
   b) In this group, select Connected Devices (from the list on the left).
   c) Find Device Manager under "Related Settings" near the bottom and select it
   d) In Device Manager, select "Universal Serial Bus Controllers" opening a list of USB devices.
   e) At the top of the window, select Action and pick "Scan for hardware changes".
   f) HOBOware should now detect the logger insertion.

3) Modify a key in the Windows Registry associated with the Optic Base Station or Waterproof Shuttle. This procedure is available in this Microsoft Knowledge Base Article in the Workaround section. When you get to the section needing the Onset Computer Corporation Vendor ID, use VID_0F1B. The Product ID for the Optic USB Base Station Product ID is PID_0070. The Product ID for the Waterproof Shuttle is PID_0A04. You will also need to know the Product ID for the loggers to detect when the logger in removed. You can use methods in the Microsoft Knowledge Base Article to find the Product ID for the loggers you are using.
 



OS X 10.11 (El Capitan) and U30, Waterproof Shuttle and RX Stations
A bug in early releases of Apple’s OS X 10.11 (El Capitan) causes failures in Onset U30 USB Weather Station, HOBO RX Remote Monitoring Station data loggers and the Waterproof Shuttle (U-DTW-1) USB communications. But this problem was fixed in OS X 10.11.4 (release 4) so we highly recommend that if you are using OS X 10.11 that you update to the latest version of that operating system.



*** Other Known Issues ***
 
* Firmware Update for UX-series loggers may not work on Windows 8. Windows 8 is no longer supported by Microsoft and updates needed to work properly with USB devices may not be available. So, we suggest either: 1) using a Windows 7 computer for Firmware Update or 2) upgrade to Windows 8.1 or Windows 10. After the Windows update, reinstall HOBOware so the correct DLL needed for Firmware Update can be installed.

* The Alarm & Readout Tool is not supported with HOBOware 3.5 or later. For questions or assistance, refer to http://www.onsetcomp.com/support.

* The Conductivity Data Assistant is not offered in the Plot Dialog for data that has been imported from Text or CSV (comma separated value) files. The Conductivity Data Assistant is only offered for U24 data files either read from disk or read out from a U24 Conductivity/Salinity logger.
 
* The RX Station Manager cannot load the Ethernet Configuration screen after power-up but before thfe RX Station has attempted to connect to HOBOlink. The error message is, "Manager is unable to retrieve configuration. Close Manager and retry." So, when powering the RX Station, leave the USB cable unplugged, allow the system to initialize and attempt connecting to HOBOlink (Connection label flashes); it does not matter if the attempt succeeds or fails. Then connect the USB cable and use RX Station Manager to access the Ethernet Configuration.

* The RX Station Manager Conditions panel does not support collection of the reading for an analog sensor where warm-up (excitation) time is more than approximately 3 seconds. In this case, an error message will appear: “Manager is unable to refresh all sensor conditions.”

* The RX Station Manager Conditions panel may not include a Smart Sensor when logging at a 1 second interval and many Smart Sensors are attached. In this case, an error message will appear: “Manager is unable to display all configured sensors.” To workaround this issue, temporarily stop logging.

* When importing HOBOware CSV (Comma Separated Value) files from HOBOlink Custom Data and Data Delivery features, you cannot use commas in the name of the series, the series units or in a series label.

* When importing HOBOware CSV files from HOBOlink Custom Data and Data Delivery features, you can embed a double quotes character (ASCII 34 or 22 hex) in the strings by escaping the double quote character with a backslash '\' character (ASCII 92 or 5C hex). So, this label could be used to show inches, "Rain on the roof \" ".

* After pasting a series into a plot, the Remove Series feature will not work correctly. It may remove the wrong series and the order of series in the Plot's Details Pane will be changed and be incorrect.

* A new feature for reading out a RX Station with HOBOware is known to be slow and error-prone when running under Windows XP or on very slow computers (for instance, a 1.6 GHz Pentium with 2 GB RAM). Windows XP support was dropped for HOBOware version 3.7.3 so this shouldn't be a problem for users with compatible computers.

* After updating the firmware of the MX1102 Temperature/Humidity/CO2 logger (with the "Update Device Firmware" item under the Help menu), you may see the firmware version being reported as R0-Pnnn where 'nnn' is the correct version number but the radio transceiver firmware, 'R',  is reported as 0. The radio firmware version will be shown correctly after removing power and then powering up the logger.

* Reordering the columns of HOBOnode Manager can result in checkbox cells of the table not working. Please leave the order of the columns in their default state.

* The new CABLE-ADAP24 external input cable for measuring DC voltages from 0 - 24 volts maximum cannot be used with HOBOnode Manager which means that new cable adapter cannot be used on an ZW HOBOnodes that take external sensors.

* Loggers launched in HOBOware 3.7.24 cannot be read out in versions of HOBOware prior to HOBOware 3.7.24. As a general rule, we discourage launching loggers in one version of HOBOware and then reading the logger out in an earlier version. Please be sure to upgrade all your versions of HOBOware.

* The Data Assistants (also called Post-Processors) available with HOBOware v3.5.0 and later must not be used with versions of HOBOware prior to version 3.5.0. In addition, the Data Assistants available with versions of HOBOware prior to version 3.5.0 must not be used with HOBOware version 3.5.0 and later.

* If you create your HOBOnode Manager database in HOBOware 3.5 or later, you will not be able to access the HOBOnode Manager in HOBOware versions prior to 3.5. If you must use a previous version of HOBOware, you will need to uninstall the current (3.5.0 or later) version and then install the older version. The HOBOnode Manager will then be accessible again in the older version of HOBOware.
 
* The HOBOnode Manager database cannot be used with any versions of HOBOware earlier than 3.2.2 once it has run the required utility for performance improvement.
 
* Not all measurement types are supported by the Import Text Data feature.

* Changing a series description or units in the Series Properties will not be reflected in the Details pane or Points table if the series was launched with a label. The legend, however will show these changes.

* Legacy files (e.g. TBI32 data files) launched with a delayed start time that occurs in a different phase of Daylight Savings time than the launch time, will plot with timestamps that do not properly follow the DST change.

* The Undo function does not work when trying to undo a pasted series.

* It is not possible to paste State series into a project file that already contains State series.

* When merging datafiles, if the datafile being merged contains state or event series that select Merge to No Series, the timestamps on the resultant plot will be invalid when saved to a project file. Also when merging project files, for series that select Merge to no Series existing axes are not used causing duplicate axes.

* When merging datafiles with State series, the resultant merged State series may cause a series color change.

* In the Alarms pane of the Series Properties window, the value slider to set an alarm may have incorrect minimum and maximum values for some of the pulse sensors.

* The Bulk Export Tool preference to include YAML headers currently does not result in YAML headers being created.

* In HOBOnode Manager, on the Alarms tab when using the "Apply default actions" to multiple alarms feature, it is possible that the next time you view one the selected alarms by clicking the alarm icon in the HOBOnode Manager table, it may not show the applied default actions. However if you re-open the HOBOnode Manager, the default actions are now there.

* When running on a non-English desktop there is the remote possibility that you may encounter a problem bringing up the Launch window.  This has been found to be a conflict in a few locales when using the 12-hour time format, and has been corrected for all tested locales.  To get around the problem should you encounter it please go to Preferences, and under the Display category, in the Date/Time section, change the Time Format to 24-hour.

* From the Export Settings Preferences pane, if selecting the option, “Include sensor serial number, or label if available,” and also selecting the option, "No quotes or commas in headings, properties in parentheses", if a label is present the sensor serial number will not be included.

* When running in a non-English locale please be aware that the keyboard accelerator keys have not been changed to adapt to the non-English language.  For example, the key to select the crosshair tool when plotting is C regardless of the language of the user interface. Please see the application Help for details on these accelerator keys.  

* When launching a HOBO Pendant with only events enabled (no temp, no battery logging), HOBOware correctly sets the logging interval to one hour (so the battery doesn't drain), but incorrectly sets the internal information used by shuttles to re-launch the logger to a one-second interval. This is fine for the initial launch, but if the logger is re-launched with either the U-DT-1 or U-DTW-1 shuttle it starts "logging" at one second, draining the battery.  It isn't logging data since it isn't supposed to, but it does wake up once a second, causing the battery to drain faster than expected.

* Plots with series that logged over the Spring or Fall time change will not display the time change.

* Occasionally HOBOware may report that communications with the logger failed - just retry the operation.

* While in a locale which formats numbers as follows "123 456 789,00", when entering a number in an input field, do not use the spacebar to input the grouping separator. The grouping separator is a no-break space character, and the spacebar will insert a space character, which the input field will treat as an invalid character. It is best to enter the number without any grouping separator(s) and when you leave the input field, the value will format itself correctly.

* When a serial logger (HOBO Weather Station, HOBO Micro Station, HOBO Energy Logger) is awaiting an interval, delayed, or button start, the sensor readings are not updated in the Status window. This is a hardware limitation. When logging begins, sensor readings will update as usual.

* At low screen resolutions (1024x768), plots with many series (and therefore many Y axes), may initially display too small.  A message "Plot Panel Too Small" will display across the plot when this occurs.  To see the plot, try maximizing HOBOware to full screen size.  If this does not work, try hiding the details pane and points table.

* Changing the units of a series using the right-click menu item "Convert Series Units" will work for everything except the Y-axis values used by that series. Use the Main Menu item "Edit | Convert Units" or the Toolbar button "Convert units for all series" instead.

* The HOBO U14 can be launched without the Temperature channel or the Relative Humidity channel selected, although there will be a warning about this condition. The logger will continue to display current conditions of those channels, but no data will be logged and alarms will not work.

* The battery state for the HOBO U23 loggers (-001, -002, -003 and -004 versions) is shown as Good at battery voltages above 2.85 V. The battery state should be shown as Good only when the voltage reads 3.1 V or higher.

* Users of the HOBO Energy Logger (H22-001) may find that they are warned, "The battery voltage on this logger is too low to use excitation power." This warning is sometimes given even when the battery voltage is high enough to supply excitation power. We suggest that you make your own decision based on the voltage reading from the Status window or from the battery gauge near the top of the Launch window.
	That dialog's warning should not be confused with the dialog whose text, "This logger's battery is very low..." is only issued when the logger battery is dangerously low. You should NOT ignore this dialog's warning.

* The Bulk Export Tool preferences may not show up in the Preferences window under some circumstances.  Closing the Preferences window and re-opening usually corrects the problem.

* Entering non-alphanumeric characters in the Help Search field can cause the search to fail. Close the Help and reopen it if this occurs.


Windows Only:
* If you are receiving a User Access Control warning every time you start HOBOware 3.2.2 or later version, be sure that you are not running HOBOware in Compatibility mode. To check this, right-click the HOBOware desktop shortcut, go to the Compatibility tab and uncheck the Compatibility options particularly that for "Run as administrator".

* HOBOware does not support roaming user profiles.

* By default, HOBOware maps all .hobo and .dtf files to itself.  This will remove the mapping from GreenLine or BoxCar Software.  If you would like to remap the file types to the original software, use the Map/Unmap buttons in the General pane of HOBOware Preferences. To use the Map/Unmap feature you'll need to run HOBOware with administrator privileges, otherwise you get a series of "error modifying registry" messages. Even while running as administrator, occasionally the Map/Unmap buttons in Preferences may produce an error message.  Simply click the button again and the mapping should proceed properly.

* If the logger you plug in has never been seen by your computer before, the Found New Hardware balloon will appear next to the Windows Taskbar and any default action on plug will not work.  If you wait until the system informs you the device is ready and unplug the logger and plug it back in, the default action on plug will then happen.

* When exporting points to Excel, it is possible that the resultant Excel file may not open in the exact same format when opened in Excel on a Macintosh system.

* When exporting details to text, it is possible that the resultant text file may not open in the exact same format when opened in a text editor on a Macintosh system.

* As described in the manual, bitmap images of the graph can be pasted directly into many applications. However, the following steps are needed to paste the graph into a WordPad document:
From the Insert menu, choose Object.
In the Insert Object dialog, click the Create New button.
Choose Bitmap Image from the list. Click OK. This should create a frame in your document.
From the Edit menu, choose Paste. The graph should appear within the frame.

Windows 7 Only:
* Occasionally when reading out a logger you will not be able to enter a file name in the Save window. Canceling this window and reading out the logger again, usually fixes this issue such that you can now enter a name.

Mac Only:
* Merging datafiles may not work on the Mac (macOS or OS X). This is an intermittent problem and will be fixed in a future release of HOBOware.

* The original version of the Pendant Base Station has a known issue that results in slower communications with versions of HOBOware for Mac.  This will not affect the validity of the data.  Pendant Base Stations with serial numbers below #961469 have this problem.  The serial number is visible through the clear plastic of the Base Station on a white label.  Please check periodically for an update to HOBOware that addresses this issue, or contact Onset Computer Corporation Technical Support (http://www.onsetcomp.com/support) for a free replacement Pendant Base Station.

* At times, it is possible that the HOBOware menu enters a disabled state, where the items in the menu are disabled. If you restart HOBOware, the menu will return to its normal state. Be sure to save any unsaved data before restarting HOBOware.

* When exporting points to Excel, it is possible that the resultant Excel file may not open in the exact same format when opened in Excel on a Windows system.

* When exporting details to text, it is possible that the resultant text file may not open in the exact same format when opened in a text editor on a Windows system.

* HOBOware for Mac may experience problems when using a Keyspan USB to Serial Adapter that is attached to a USB hub.  It is recommended that Keyspan USB to Serial adapters be attached directly to the USB port on the computer to avoid this issue.

* For HOBOware 3.5.0 and above, the Mac installer will only place the HOBOware application in /Applications. Previous versions allowed installing HOBOware anywhere in the file structure.

* The HOBOware updater will acknowledge that a previous version of HOBOware is installed in other places in the file structure and will allow the updater to run but the updater will only place the HOBOware v3.5.0 (and above)  application in /Applications.

* For HOBOware 3.5.0, beware that in the future, you will be able to install this version over later versions of HOBOware but you will get no warning that you are overwriting a newer version of HOBOware with an older version. Versions of HOBOware previous to v3.5.0 gave a warning about this downgrade.

___________________________

Questions or comments?  Please direct to Onset Computer Corporation at 
1-800-LOGGERS (1-800-564-4377) or go to http://www.onsetcomp.com/support/contact and fill out the form.


